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PLD D2-115 da Altera

O que é um PLD?

E um dispositivo légico programavel (Programmable logic device - PLD) utilizado
para construir circuitos digitais.

Ao contrario de uma porta légica, que tem uma fungdo fixa, um PLD tem uma fungdo

indefinida quanto a sua fabricagdo. Antes de se utilizar um PLD num circuito, este
deve ser programado (via linguagem ou via esquematico).
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PLD D2-115 da Altera

Como o PLD guarda a configuragdo?

Um PLD é uma combinacdo de dispositivos ldgicos e de memdéria. A memoria é
usada para guardar o padrdo que é dado ao chip durante a programagao. Muitos dos
métodos para armazenar dados no circuito integrado foram adaptados para serem
usados em PLDs. Isto inclui:

SRAM

Células EPROM, EEPROM

Memoria Flash

PLDs baseadas em SRAM tem que ser programadas cada vez que a energia é ligada
isto normalmente é feito por outra parte do circuito. Uma célula EPROM é um
transistor MOS (semicondutor de 6xido metdlico) que pode ser comutada por uma
carga eléctrica permanente aplicada no seu eletrodo 'gate'. Uma meméria FLASH é
ndo-volatil, retendo a informagdo mesmo que a energia elétrica seja desligada.
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PLD D2-115 da Altera
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PLD D2-115 da Altera
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¢ Questio: Como fransformar o projeto de um sistema digital
(normalmente representado por um desenho contendo um conjunto de
simbolos légicos interligados) em um circuito fisico real, implementado
com Circuitos Integrados (CI’s)?
Utilizaremos como exemplo o circuito logico de alerta de abertura do
cinto de seguranca, representado na figura seguinte.

K Bell Warn
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(a) Digital circuit (b) Physical
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PLD (Programmable Logical Devices) caracterizam-se por permitir ao projetista
configurar as células logicas do CI de modo adequado a atender ao projeto, sem a
necessidade de fabricagdo de componentes especiais.

Tipos de PLD:

* SPLD (Simiple Programmable Logic Devices): circuitos com centenas de portas
logicas basicas (AND e OR) e eventualmente registradores, que podem ser
interconectadas pelo projetista através de ferramentas de configuracio de
hardware:

* CPLD (Complex Programmable Logic Devices): circuitos com centenas de
elementos logicos (cada um deles similar a um SPLD), que podem ser
configurados individualmente e interconectados pelo projetista através de
ferramentas de configuragao de hardware;

* FPGA (Field Programmable Gate Arrays): circuitos com centenas de blocos
logicos programaveis individualmente, atraveés de blocos de memoria (tabelas de
consulta), que podem ser interligados através de uma matriz de chaveamento,
também programavel pelo projetista através de ferramentas de configuracio de

hardware. ¢

!
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FPGA (Field Programmable Gate Arrays): circuitos com centenas de blocos
logicos programaveis individualmente, que podem ser interligados através de
uma matriz de chaveamento.
S =0 =] =] =]
el ¢ S : 5 )
Bxemplode | |, | g e (] s
arquitetura de LT W I T e
um FPGA — 2 ' . ?_ ' '
o =l EE: o . ?l” ..... ::>
— | Bloco i Bloco Bloco
Ibgico  —itih | Ibgico Iégico
[ ] 2_ clk : clk clic
o T T T
L ()
] Bloco Bloco Bloco
o l6gico ; l6gico I6gico
L | clk clk clk
iy iy 7 UL
O Interconexfio programsvel NOTA: As entradas de clock
== Segmento de conaxao podem tar caminhos
————— Caminho para interconexao Fonte: R. Tocci aspadale do ntaegonousic
¢
* P4g. 486 TOCCI, 112 edicdo 9 kroton
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Resumo da organizacio logica de um FPGA:
Bloco de Memoéria (LUT) + FF + MUX - CLB (Blocos Légicos Configuraveis)
Sclect
Switch Matrix
(Matriz de
Interconexdaes)
I1I0B
(Blocos de
Entrada e Saida)
[
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Correcao de Erros
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O Projeto
Sistema simples de alarme de automdvel para detectar, quando a Chave de
Ignicdo esta ligada, se o Cinto de Seguranga néo esté afivelado ou uma das
Portas est4 aberta.
s T e —
/< Luz de Alerta para _2 ~——
:\/ - Porta Aberta P
{ = —
N ,V_,,/ = __,/'/ ‘\-"’“\» o
R /"‘( Luz de Alerta para __%
52 Cinto de Seguranga i \ f
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Passo a passo
Iniciar um Novo Projeto

Para comecar a trabalhar em um projeto novo, primeiro temos que definir um
escopo para este projeto. O “software” Quartus |l facilita esta tarefa
fornecendo suporte na forma de um Assistente (“Wizard”). A criagdo de
um Novo Projeto segue as etapas detalhadas a seguir.

a) Selecionar File > New Project Wizard para iniciar o Assistente de Novo
Projeto o qual direciona a criagdo e configurages preliminares de um Novo
Projeto.

b) Na janela “New Project Wizard: Introduction” , clicar em Next.

!
13 krotone
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€4 Quartus || 64-Bit
File Edit View Project Assignments Processing Tools  Window  Help &
1 Mew.. Ctrl+ e o ¢
£ Open.. cirl+0 N Home
Close Ctrl+F4
] hew Pt Vil Start Designing
[ZZ OpenProject... ctrl+3
Save Project
Close Project ﬁ
A Save Ctrl+5
Save As...
' New Project Wizard
gl saveal Ctrl+shift+5
File Properties...
!
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Janela “New Project Wizard: Add Files”. O Assistente de Novo Projeto
permite incluir arquivos pré-existentes (se houver) no Projeto.

Now Projoct Wizared: Ard Filos [paga 2 af §] ==

Selec oz desion Hles youwant 1o includs i the piojese. Chck Add Al 1o 3 ol design fivs n e
et dia ek o M progect. Rloba: you con ahisys sod design ke b ba progel Bl
Ele e | ]
Fie rame [Tipe [Crmry |Deaign eniryiay_ | HOL wermion Acda

(T} r
Specity the peth names of ery non-defeul Ereries e

= Back: Nea: | Fineh Coslr |£
= = kroton
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Na janela “New Project Wizard: Family & Device Settings”:

f.1) Especificar o tipo de dispositivo no qual o circuito projetado sera
implementado.

No campo “Device Family — Family:”, escolher Ciclone IVE como Familia do
dispositivo de destino.

f.2) Pode-se deixar o “software” Quartus Il selecionar um dispositivo especifico
na familia, ou podemos escolher o dispositivo explicitamente. Utilizaremos esta
Gltima abordagem

No campo “Target device” escolher a opgao “Specific device selected in
‘Available devices’ list”.

f.3) No campo “Available devices” aparece uma lista de dispositivos
disponiveis, escolher o dispositivo denominado EP2C70F896C6 que é um
PLD utilizado na Placa Didatica de Desenvolvimen

16 k[otqnlt
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€4 New Project Wizard

Family & Device Settings [page 3 of 5]

Select the family and device you want to target for compilation.
You can install additional device suppart with the Install Devices command on the Tools menu.

To determine the version of the Quartus II software in which your target device is supported, refer to the Device Support List webpage.

Target device

) Auto device selected by the Fitter

Specific device selected in ‘Available devices' list

Other: nfa

Avaiable devices:

Device family Show in 'Avalable devices' fist
Family: [Cyclone IVE v]  Package: [any -]
Devices: [Al Pin count: [any B3|

Core Speed grade: [Any

=)

Name filter:

Show advanced devices

Name Core Voltage LEs  User1/Os Memory Bits Embedded multiplier 5-bit elements P 4
EPACE75F2317 LV 75408 293 2810380 400 4
EPACE75F2318L LoV 75408 293 2810380 400 4
EP4CE75729C6 1.2V 75408 427 2810380 400 4
EpacE7 Lo ss ey sosso oo
EP4CE75729C8 LV 75408 427 2810880 400 4
EP4CE75729C8L LoV 75408 427 2810880 400 4
EP4CE75729C5L LoV 75408 427 2810880 400 4+ 7
EP4CE75F2917 LV 75408 427 2810880 400 4
EP4CE75F2918L LoV 75408 427 2810380 400 4 %
[ i v

<Back | [ Mext> |[ Finsh |[ cancel |[ heb | ¢
17 kroton
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Resumo das Configurag@es escolhidas:
‘& New Project Wizard .— — . Tk W (S
Summary [page 5 of 5]
When you click Finish, the project will be created with the following settings:
Project directory: Crgltera\14.0
Project name: aulal
Top-evel design entity: aulal
Number of files added: 0
Number of user libraries added: 0
Device assignments:
Family name: Cydone VE
o e
EDA tools:
Design entry/synthesis: <None> (<hone >)
Simulation: ModelSim-Altera (vHDL)
Timing analysis: 0
Operating conditions:
VCCINT voltage: 1
Junction temperature range: 085°C
[ <Back vext> | [_Foeh | [ Concel ][ rep |
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Para descrever o circuito no formato de Captura de Esquematico deve-se usar o Editor
Gréfico do Quartus IL conforme as etapas detalhadas a seguir.

a)  Selecionar File > New para obter a janela da Figuwra 14. Escolher “Block Diagram /
Schematic File” e clicar em OK. Isso abre a janela do Editor Grafico (Figurals).

(e T, W]

e Quam 1 Project
- SOFC Bl Systen

SyskenVerboaHOL Fi
TelSeipt Fle
ek DLl

i ¥HOL Fie

= Meen Fies
Haradesanal s Fom) i
My I sicsion Fis

& MetbesteryDebuggrg e

T Sy Souoms ard FrocesFlg
Logo natess Inzifase Fie
SigedTap | Lok anaom Fla
Wecton Wasstom Fi

5 e Fies
AROL ok Pl
Black Syrbal P
Chin Desarion Fie
Syeepes Dasgn Corsrskes Pl
TenFis

[ ] o |

4]
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O Editor Gréfico oferece uma série de bibliotecas que incluem elementos
de circuito que podem ser importados para um esquematico. Dé um duplo
cligue no espag¢o em branco na janela do Editor Gréfico, ou clique no
icone na barra de ferramentas que se parece com uma porta AND .

T

Va em “libraries”, em seguida, expandir a biblioteca “primitives”,
seguido de expansdo da biblioteca “logic” que compreende as portas
légicas. Selecione “and2”, que é uma Porta E de duas entradas, e clique
em OK. Agora, o simbolo da Porta E aparecera na janela do Editor
Gréfico. Usando o mouse, mova o simbolo para um local conveniente e
cliqgue para coloca-lo la. Importar a segunda

22 k[otqn'e
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LR E RS ST IO

Figura 20 Importar os simbolos das Portas Logicas e organiza-los na janela do Editor
Grafico.
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Pin Properiies g

General ] Fornat |

To create nuitiole pins, enter aname in AHDL buz notation (for examdle.
namel2 O] or enter a comma-s=parated list of names.

i namefsl: [Chave_lgnicas

Difauk valus: [VET -

Canecelar

Vamos acrescentar trés saidas intermediarias no circuito!!!

25 !S[Otonle

sor educar

Aula 8- Lab

Pinos de Entrada do. Circuito. . -

gnicac e —

. Baidas Intermedia

SLTEUT [ (Bensor_Cinto

| {Sensar it

BT e inte

- {'Bensor_Porta D_a%.b]_

26 !(igthoqle
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Compilar o Circuito Projetado

O arquivo do diagrama esquematico descrito — Luzes_de_Alerta.bdf, sera
processado por vérias ferramentas do Quartus Il que irdo analisar o arquivo,
sintetizar o circuito, e gerar uma implementacéo deste circuito para o chip de
destino. Estas ferramentas séo controladas pelo programa aplicativo chamado

Compilador.

Para executar o Compilador selecionar Processing > Start Compilation, ou

clicar no icone da barra de ferramentas horizontal.

-

A medida que a compilacéo passa pelos varios estagios, seu progresso
é relatado em uma janela no lado esquerdo da tela do Quartus Il (janela
“Tasks”). O sucesso (ou insucesso) do processo de compilagdo é

indicado em uma caixa de dialogo,
27

Aula 8- Lab
s Rl =2
Fle Edt View Project Assgiments Processng Took Window Help 5
DS P ¥ 2@ 9 o [i[aka Y LSS D >
Project Navigator FEx Compilation Report - sua i &) aulalbe
s FEaVADE-077ANNNOON
Ay cydane I E: EP4CELISF29CT

B a1 S

Simulagao

Aparece status na
janela Tasks!!

o »
B ticrarchy | ZFes | Foe 4 8
Tasks

T8 x :
) ]|\

Task

Fow: [Conglstion

ST

F Analyss 6 Synthesis

P yoerays—
@0 BB 7

Type ID Message

System J\_Processing (46]
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Atribuic&do de Pinos do PLD w

Assignments > Pin Planner

\ﬂ-o ©) - W Sistemas Digitais IAula 3 final Lab
Inido  Insert  Design \mu‘m\mum Revisio  Edbigio

vvmvm uum/cm-wnwm:’ - 5_4 - ‘__l = ”

Me fon vew Procemrg Toos  vanomw

Search tera.com

3 Gows  d8x|

-:E 28 EHGE

i

I 1)

Heos
8

& axn
fley | A -
)
o Locaton 10 8ark
¥
e |
@
29 kr_qttgnlt
Aula 8- Lab
Atribuicdo de Pinos do PLD
Assignments > Pin Planner
Y23
Y24
TAA22 TAA23 AD27 Acz7 i
! ! ! !. . .! ! ! ! !
SW17 SW16 SW15 SW14  SW3 SW2 SwWi Logic"0”
Figure 4-8 Connections between the slide switches and Cyclone IV E FPGA
30 krotonle
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Table 4-1 Pin Assignments for Slide Switches

Signal Name FPGA Pin No. Description 1/0 Standard
SW[0] PIN_AB28 Slide Switch[0] Depending on JP7
SW[1] PIN_AC28 Slide Switch[1] Depending on JP7
SW[2] PIN_AC27 Slide Switch[2] Depending on JP7
|SW[3] PIN_AD27 Slide Switch[3] Depending on JP7
SW(4] PIN_AB27 Slide Switch[4] Depending on JP7
SW[5] PIN_AC26 Slide Switch[5] Depending on JP7
SW[6] PIN_AD26 Slide Switch[6] Depending on JP7
SWIT] PIN_AB26 Slide Switch[7] Depending on JP7
SW(8] PIN_AC25 Slide Switch[8] Depending on JP7
SW[9] PIN_AB25 Slide Switch[9] Depending on JP7
SW[10] PIN_AC24 Slide Switch[10] Depending on JP7
SW[11] PIN_AB24 Slide Switch[11] Depending on JP7
SW[12] PIN_AB23 Slide Switch[12] Depending on JP7
SW[13] PIN_AA24 Slide Switch[13] Depending on JP7
SW[14] PIN_AA23 Slide Switch[14] Depending on JP7
SW[15] PIN_AA22 Slide Switch[15] Depending on JP7
SW[16] PIN_Y24 Slide Switch[16] Depending on JP7
SW[1T7] PIN_Y23 Slide Switch[17] Depending on JP7
s kooton®
Aula 8- Lab

Table 4-3 Pin Assignments for LEDs

Signal Name FPGA Pin No. Description /O Standard

LEDR[0] PIN_G19 LED Red[0] 2.5V

LEDR[1] PIN_F19 LED Red[1] 2.5V

LEDR[2] PIN_E19 LED Red[2] 2.5V

LEDR[3] PIN_F21 LED Red[3] 2.5V

LEDR[4] PIN_F18 LED Red[4] 2.5V

LEDR[5] PIN_E18 LED Red[5] 2.5V

LEDR[6] PIN_J19 LED Red[6] 2.5V

LEDR[7] PIN_H19 LED Red[7] 2.5V

LEDR[8] PIN_J17 LED Red[8] 2.5V

LEDR[9] PIN_G17 LED Red[9] 2.5V

LEDR[10] PIN_J15 LED Red[10] 2.5V

LEDR[11] PIN_H16 LED Red[11] 2.5V

LEDR[12] PIN_J16 LED Red[12] 2.5V

LEDR[13] PIN_H17 LED Red[13] 2.5V

32 kroton'e
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LEDR[14] PIN_F15 LED Red[14] 2.5V
LEDR[15] PIN_G15 LED Red[15] 2.5V
LEDR[16] PIN_G16 LED Red[16] 2.5V
LEDR[17] PIN_H15 LED Red[17] 2.5V
LEDG[0] PIN_E21 LED Green[0] 2.5V
LEDG[1] PIN_E22 LED Green[1] 2.5V
LEDG[2] PIN_E25 LED Green[2] 2.5V
LEDG[3] PIN_E24 LED Green[3] 2.5V
LEDG[4] PIN_H21 LED Green[4] 2.5V
LEDG[5] PIN_G20 LED Green[5] 2.5V
LEDG[6] PIN_G22 LED Green[6] 2.5V
LEDG[7] PIN_G21 LED Green[7] 2.5V
LEDG[S] PIN_F17 LED Green[8] 2.5V

33 kroton'e
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Fle Edit View Project Assignments Processing Tools Window Help 5
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Project Navigator 18 x [ g Compilation Report - aulal 0| = aulalbdf B ‘
Crtly FEAGACE-OIIINNNOON " FEaeHd S 8 an
% Cydone IV E: EP4CE115F29C7
@aulal‘;@
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Atribuicéo de Pinos do PLD

Assignments > Assignment Editor

Deskiop/Teste/nule] - il — ——_ —— - W

Processng  Tools Window Help 5

T HEY S D ron 0 29 P Ale T

; | 'g# Compiation Report -aulal || | R aulat.bdf B | @  AssgnmentBditor [ ‘
<<new>> v [V]Filter on node names: = - CatEgorv:[Nl -

tatu From To Assignment Name value Enabled Entity Comment Tag
1 /M, Sensor_Porta Location PIN_Y23 Yes

2 « [ % sensor_Cinto  Location PIN_Y24 Yes
3 N o chave..nicao  Location PIN_AAZZ Yes
4+ [ 24 fsensor_Cinto Location PIN_H15 Yes
5 I 4 Led Ports  Location PIN_G15 Yes
5 « I o Led Cinto Location PIN_F15 Yes
7 « [ 22 Alarme Location PIN_H17 Yes
8

<<new>> <<new>> <<new>>

kroton"
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Aula 8- Lab

Programacé&o do PLD

Va em Tools > Programmer > Hardware Setup > USB- Blaster [USB-0]
e add o arquivo. sof
[Ty e———— /e s o L W=

Fie Edt View Processing Toos Window Hep D Search altera,com @

2 Hardnare Setp...] No Hardware Mode: [TTAG v) ragress: |

Enable real-time ISP to allow background programming (for MAX IT and MAX V devices)

e Fie Device Checksum  Useresde  Program/  Verfy  Bank-  Examne
W Start Configure Chedc
i Stop
3 Auto Detect
3 Delete.
[ Add File...
& change Fie.
[ty eerie- ] | g
el Save File

¢

|: kn:)l:onI
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Aula 8- Lab

Programacé&o do PLD

Apos isso clique em start e acompanhe o progresso

4 Programmer - C.JUsers/Crstiano/Desktop/ - aulal - [Chain3.cdf] A o o |

Fie Edt View Processng Toos Window Hep %) Search altera.com ]

Mode; [ITAG ~]  Progress:

ing (For MAX I and MAX V devices)

Fie Device Chedsum  Usercode  Program/  Verfy  Bank-
[ ohswe | Configure Check

diostop

3 Auto Detect

¥ pelete

[ Add File...

5 Change Fie.

|l save File

(¥ Add Device.
Thup

J Down

¢

| koton

Aula 8- Lab

Através das chaves e LEDs, testar o circuito projetado e programado no PLD,
completando a Tabela Verdade abaixo:

Variaveis de Entrada Variaveis de Saida
SW17 SW16 SW15 LEDR17 LEDR15 LEDR14 LEDR13

Chave_lgni¢do Sensor_Porta Sensor_Cinto /Sensor_Cinto LED_Porta LED_Cinto Alarme

0 0 0

» B P B, O O O
m P O O r LB O
R, O B O Rr O K
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